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Introduction 
 

Digital competence is a key competence of the fourth industrial 

revolution. Confident mastery and use of digital technologies for 

education, employment, work, leisure and participation in public life 

is critically important for every citizen of Ukraine. 

The aim of the course is to develop skills and abilities in such 

areas as: information and media literacy, communication and 

collaboration, creating digital content, protecting information in the 

digital environment, solving problems and lifelong learning. 

The course is based on the European conceptual framework of 

digital competences for EU citizens (DigComp 2.1.). 

The course "Basics of digital technologies" is divided into two 

content modules: 

1. Digital technologies for working with text and data; 

2. Creation and use of digital content. 

Mastering of each module is checked using test tasks in the 

Moodle environment. 

To successfully pass the course, the student must complete 15 

laboratory works and pass two modules. Each laboratory work is 

evaluated in the range of 0-4 points. Each module - 0-20 points. To 

successfully pass the discipline, a student must score at least 60 points. 

The form of final control is an exam. 
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Вступ 
 

Цифрова компетентність є ключовою компетенцією 

четвертої промислової революції. Впевнене володіння і 

використання цифрових технологій для навчання, 

працевлаштування, роботи, дозвілля та участі в суспільному 

житті є критично важливою для кожного громадянина України.  

Завданням курсу є формування вмінь і навичок в таких сферах 

як: інформаційна грамотність та медіа грамотність, комунікація 

та співпраця, створення цифрового контенту, захист інформації у 

цифровому середовищі, розв’язання проблем і навчання 

впродовж життя. 

За основу курсу взято концепцію розвитку цифрових 

компетентностей для громадян ЄС (DigComp 2.1.).  

Вивчення курсу «Основи цифрових технологій» поділено 

на два змістових модуля: 

1. Цифрові технології роботи з текстом і даними; 

2. Створення та використання цифрового контенту. 

Засвоєння кожного модулю перевіряється за допомогою 

тестових завдань у середовищі Moodle. 

Для успішного проходження курсу студенту необхідно 

виконати 15 лабораторних робіт та здати два модуля. Кожна 

лабораторна робота оцінюється в діапазоні 0-4 бали. Кожен 

модуль – 0-20 балів. Для успішного складання дисципліни 

студент має набрати не менше 60 балів. Форма підсумкового 

контролю – екзамен. 
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Module 1 

Laboratory work № 1 

DIGITAL TECHNOLOGIES OF THE NUWM AND 

DIGITAL COMPETENCES  

 
Goal: To acquire skills in working with the services and the 

website of the NUWM. Digital competences testing. 

 

Task 1: Familiarize yourself with the structure of the NUWM 

website. https://nuwm.edu.ua/ . 

1. On the website, you can find information about the institute 

where you study, the graduation department, the brand book of 

the university, the plan of the educational building where classes 

are held. 

2. Corporate mail. Students need to check their corporate mail and 

send a letter with completed laboratory work tasks to the teacher. 

3. Electronic journal. 

4. Electronic class schedule 

5. LMS Moodle. https://exam.nuwm.edu.ua/ . Students need to log 

in to the Moodle educational platform and familiarize themselves 

with its structure and purpose. 

6. Repository. http://ep3.nuwm.edu.ua/ Students need to find an 

electronic guide for studying subjects. 

7. Wikisytet. Students familiarize themselves with the university 

website 

Task 2: Organization of work on course study 

- Students get acquainted with the syllabus of the discipline, the 

evaluation system. 

- Students need to find educational videos on YouTube by 

course topics. It is suggested to review the courses by Dmytro 

Kivganov, about Word , Excel . 

https://www.youtube.com/c/DmitriyKivganov 

 

Task 3: Assessment of own digital competence 

Students need to familiarize themselves with the structure of the 

framework of digital competences for citizens of Ukraine. 

https://osvita.diia.gov.ua/uploads/0/1364-1_compressed.pdf 

https://nuwm.edu.ua/
https://exam.nuwm.edu.ua/
https://www.youtube.com/c/DmitriyKivganov
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To test digital literacy skills, students must pass the Digigrams 

test from the Ministry of Digital Transformation of Ukraine. 

https://osvita.diia.gov.ua/ 

If desired, the student can choose one of the courses offered by 

the Diia portal. 

Due to the large amount of time spending for testing (30-40 

minutes), students solve tasks independently. 

Report on laboratory work #1. 

The results of the Digigram test in the form of a certificate must 

be uploaded to the Moodle platform. 

 

 

Laboratory work № 2 

TEXT FORMATTING USING WORD STYLES 
 

Goal: Create a document using WORD styles. Get skills in text 

formatting using styles. 

 

Task execution procedure: 

1. Create a new document. 

2. In the created document, form its structure: 

Page 1 – Title page; 

Page 2- Contents; 

Pages 3–5 – Chapters 1–3; 

Page 6 – Conclusions; 

Page 7 – List of literary sources. 

 Each element of the text structure (title page, contents, 

chapters, conclusions, list of literary sources) must be started from a 

new page. To do this, at the end of each element, set the command 

Page break. To display the mode show all symbols, use the Ctrl + Shift 

+* key combination or by clicking the icon in the Home → 

Paragraph menu. 

In show all symbols mode breaks are set between sheets using the 

command Layout → Page Setup → Insert page and section breaks → 

Section breaks, Next Page. 

 

https://osvita.diia.gov.ua/
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3. On the site http://pidruchniki.c o m/ , (or similar) copy according to 

the variant the structure for the essay in the following structure (Fig. 

1). (student chooses the text independently).    

 
Fig. 1. Structure of the essay 

 

4. Necessarily clear the formatting, for this you need to select the 

entire text Ctrl+A and use the Clear Formatting command (Fig. 2). 

The Clear Formatting command is also recommended to be used 

before working with a document that is made up of fragments of other 

documents. This command formats all selected text in Normal style, 

all other effects will be removed.  

 
Fig. 2. Styles menu 

5 . The Clear formatting command does not remove hyperlinks, 

therefore it is additionally necessary: 

http://pidruchniki.com/
http://pidruchniki.com/
http://pidruchniki.com/
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• select all text " Ctrl + A " 

• press the key combination "Ctrl+Shift+F9" 

6. Select the entire document and apply the Normal style to it by 

following the command sequence Home → Styles → Normal, with the 

following characteristics (Fig. 3). 

 
Fig. 3. Normal style properties 

 

7. Apply the Heading 1 style for section names. To do this, you need 

to select the title of the 1st section, and then execute the sequence of 

commands: Home → Styles → Heading l 1. Then set the 

characteristics for the Heading 1 style (Fig. 4). 

 
Fig. 4. Style properties Heading 1 
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Similarly, apply the Heading 1 style for other section names. To 

do this, select the appropriate names of the sections and execute the 

sequence of commands: Home → Styles → Heading 1. 

8. Apply the Heading 2 style to the names of the subdivisions. To do 

this, select the name of subsection 1.1, and then execute the sequence 

of commands: Home → Styles → Heading 2. Then set the 

characteristics for the Heading 2 style (Fig. 5). 

  
Fig. 5. Style properties Heading 2 

Similarly, apply the Heading 2 style for other section names. To 

do this, select the appropriate names of the subdivisions and execute 

the sequence of commands: Home → Styles → Heading 2 . 

9. Create the content of the document. To do this, you need to go to 

page #2 of the document and write CONTENTS in the first line (all 

capital letters, font size 14 pt, bold font, alignment in the middle). 

Then go to the second line of this page and execute the sequence of 

commands: References → Table of contents → Contents... 

10. Draw up the title page (Fig. 6). Format the title page as follows: 

• 1–3 lines aligned in the center, normal font, font size 14 pt, 

single line spacing; 

• 4 line alignment in the center, bold font, font size 14 pt; single 

line spacing, paragraph→space→before→150pt; 

• 5–9 lines of width alignment, normal font, font size 14 pt, 

single line spacing; paragraph→indent→left→10cm; 
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• 5th line (additional formatting) paragraph → space → before 

→ 150pt; 

• 10 line center alignment, font normal, font size 14 pt, line 

spacing single, paragraph→space→before→150pt 
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•  

 
Fig. 6. Title page 

11. Number the pages. For this, a sequence of commands is executed: 

Insert → Header&Footer → Page number → Top of page → Right 

(Plain number 3). 

Remark! The title page and the 2nd page (Table of Contents) 

are not numbered. Numbering starts from the 3rd page. 

 

Report on laboratory work #2. 

The report consists of a title page, table of contents, 3-4 

chapters, in each chapter 2-3 subsections, conclusions, a list of used 

sources. The report must be submitted on the Moodle platform.  
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Laboratory work № 3 

FORMATTING TABLES, FIGURES, FORMULAS 

USING WORD STYLES 
 

Goal: To acquire the skills of formatting title pages, tables, 

figures, formulas. 

 

Task 1. Create the 

cover page of the essay using 

the Insert tab → Pages → 

Cover page, when formatting, 

use your own surname, name 

of specialty, name of subject, 

year of admission. 

 

 

 

 

 

 

 

 

 

Task 2. Creation of formulas and symbols in the text 

To insert symbols, use the tab Insert → Symbol. 
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To insert an equation, use the tab Insert → Equation → Insert 

new equation. 

Type the equations according to your own number in the list in 

the group log. 
1 

{
 
 

 
 𝑁0𝜆𝜈

𝜕𝑇𝜈(𝑥𝜈,𝐹𝑜)

𝜕𝑥𝜈
|
𝑥𝜈=𝑅𝜈

=
𝑁1

𝑅𝜈,𝜈+1
× 

 × [𝑇𝜈+1(𝑥𝜈+1, 𝐹𝑜)|𝑥𝜈+1=0 − 𝑇𝜈(𝑥𝜈, 𝐹𝑜)|𝑥𝜈=𝑅𝜈]     

𝜆𝜈
𝜕𝑇𝜈(𝑥𝜈,𝐹𝑜)

𝜕𝑥𝜈
|
𝑥𝜈=𝑅𝜈

− 𝜆𝜈−1
𝜕𝑇𝜈+1(𝑥𝜈+1,𝐹𝑜)

𝜕𝑥𝜈+1
|
𝑥𝜈+1=0𝜈+1

= 𝑓
2
(𝐹𝑜)

  

2 ℓ𝜈 = ℓ𝜈−1[сℎ√𝑝 𝛽
𝜈−1

⁄ + 1 𝑅𝜈−1,𝜈
∗ ⋅⁄ √𝑝 𝛽

𝜈−1
⁄ 𝑠ℎ√𝑝 𝛽

𝜈−1
⁄ ] +  

 +𝜒𝜈−2,𝜈−1ℓ𝜈−1
∗ [𝑠ℎ√𝑝 𝛽𝜈−1⁄ + 1 𝑅𝜈−1,𝜈

∗ ⋅⁄ √𝑝 𝛽𝜈−1⁄ 𝑐ℎ√𝑝 𝛽𝜈−1⁄ ] 

3 𝑇𝜈(𝑥, 𝐹𝑜) = ∑ [∑ 𝛺𝑛(𝜇𝑛,𝑙
𝜈 (𝑥), 𝜙

𝑛
)∞

𝑛=0 ⋅ 𝐻ℓ

(𝑛)(𝐹𝑜) +𝑚
ℓ=1   

+∑
𝐻ℓ(𝑝𝑘)

𝜓′(𝜙𝑛,𝑝𝑘)
𝑄(𝑝

𝑘
, 𝜇
𝑛,𝑙
𝜈 (𝑥))∞

𝑘=1 ⋅ 𝑒𝑥𝑝( 𝛾2𝐹𝑜)] +𝑧𝜈
∗(𝑥, 𝐹𝑜).  

4 𝐹𝜈−1,𝜈(𝑝) = 𝐹𝜈−2,𝜈−1(𝑝)[сℎ√𝑝 𝛽
𝜈−1

⁄ +

+ 1 𝑅𝜈−1,𝜈
∗ ⋅⁄ √𝑝 𝛽

𝜈−1
⁄ 𝑠ℎ√𝑝 𝛽

𝜈−1
⁄ ] +  

+𝐹𝜈−2,𝜈−1
∗

(𝑝)[𝑠ℎ√𝑝 𝛽𝜈−1⁄ + 1 𝑅𝜈−1,𝜈
∗ ⋅⁄ √𝑝 𝛽𝜈−1⁄ 𝑐ℎ√𝑝 𝛽𝜈−1⁄ ]  

5 𝐻0(𝑝) = −ℎ0𝐵𝑖0𝑓0(𝑝) + ℎ0𝐵𝑖0𝑀0𝑧1
∗(0, 𝑝) − 𝛼0𝑧1

∗′(1, 𝑝);  

𝐻1(𝑝) = ℎ1𝐵𝑖1𝑓1(𝑝) − 𝛼1√𝑝 𝛽
𝑚

⁄ 𝐹𝑚,𝑚+1
∗

(𝑝) + ℎ1𝐵𝑖1𝑀1𝐹𝑚,𝑚+1(𝑝)  

6 
𝑧𝜈
∗(𝑥, 𝐹𝑜) = ∑ 𝛽

𝜈
𝑛 𝐹𝑜

𝑛

𝑛!
𝜙
𝜈
(2𝑛)(𝑥)∞

𝑛=0 + 𝛽
𝜈
∗ ∑

𝛽𝜈
𝑛

𝑛!

∞
𝑛=0 ∫ (𝐹𝑜 −

𝐹𝑜

0

−𝜃)𝑛
𝜕2𝑛

𝜕𝑥2𝑛
𝑊𝜈(𝑥, 𝜃) 𝑑𝜃  

7 𝛺𝜈,2𝑘+1(𝐹𝑜) =
1

(2𝑘+1)!
∑

(2𝑗+1)!

(𝑗−𝑘)!
𝑎𝜈,2𝑗+1𝛽𝜈

𝑗−𝑘𝐹𝑜𝑗−𝑘
[𝑚−1/2]

𝑗=𝑘   

 𝜙
𝜈
(𝑥) = ∑ 𝑎𝜈,𝑘𝑥

𝑘𝑚
𝑘=0  

8 𝑤𝜈(𝑥, 𝐹𝑜) = ∑ 𝑎𝜈,𝑗
∗ 𝐹𝑜𝑗𝑥𝑗𝑚

𝑗=0   

𝛺𝜈,2𝑘(𝐹𝑜) =
𝛽𝜈
∗

(2𝑘)!
∑

(2𝑗)!(2𝑗)!

(3𝑗−𝑘+1)!
𝑎𝜈,2𝑗
∗ 𝛽

𝜈
𝑗−𝑘𝐹𝑜3𝑗−𝑘+1

[𝑚/2]

𝑗=𝑘   

9 𝜇
𝑛,1
𝜈 (𝑥) =

[∑ 𝑎𝑛−𝑗,𝜈(𝑥)𝜂𝜈,𝑗
𝑛
𝑗=0 +𝜒

𝜈−1,𝜈
1 √𝛽𝜈−1𝛽𝜈⁄ ∑ 𝑎𝑛−𝑗−1,𝜈

∗ (𝑥)𝜂
𝜈,𝑗
∗𝑛−1

𝑗=0 ] −  

−[√𝛽𝜈 𝛽𝜈−1⁄ ∑ 𝑎𝑛−𝑗,𝜈(𝑥)𝜉𝜈,𝑗 + 𝜒𝜈−1,𝜈 ∑ 𝑎𝑛−𝑗,𝜈
∗ (𝑥)𝜉𝜈,𝑗

∗𝑛
𝑗=0

𝑛
𝑗=0 ], 

10 𝛧1(𝜏) = 𝑓′(𝜏), 𝛧2(𝜏) = 𝑓″(𝜏), ⋯ , 𝛧𝑛(𝜏) = 𝑓
(𝜏)
(𝑁)  
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𝑓
(𝜏)
− 𝑓

(𝜏)
= ∫ 𝛧1(𝜂)

𝜏

0
𝑑𝜂, 𝑓

(𝜏)
(𝑘) − ∑ 𝑓

(0)
(𝑘) 𝜏

𝜈

𝜈!

𝑘−1
𝜈=0 = ∫

(𝜏−𝜂)𝑘−1

(𝑘−1)!

𝜏

0
𝛧𝑘(𝜂)𝑑𝜂  

11 
𝜙′(𝑝

𝑘
) =

1

2𝛾𝑘√𝛽2
[(1 + 𝜒1,2) (√

𝛽2

𝛽1
+ 1) 𝑠𝑖𝑛 𝛾

𝑘
(√

𝛽2

𝛽1
+ 1) + (1 −

𝜒
1,2) (√

𝛽2

𝛽1
− 1) 𝑠𝑖𝑛 𝛾

𝑘
(√

𝛽2

𝛽1
− 1)], 𝜇1,𝑛(𝑥) =

1

(2𝑛)!

𝑥2𝑛

𝛽1
𝑛 , 

12 
𝜙
𝑖
=

1

(2𝑦)!

1

𝛽2
𝑖 [(1 + 𝜒1,2) (√

𝛽2

𝛽1
+ 1)

2𝑖

+ (1 − 𝜒
1,2
) (√

𝛽2

𝛽2
− 1)

2𝑖

],  

𝜒
1,2
=

𝜆1

𝜆2
√
𝑎1

𝑎2
,  

13 
𝛵3(𝑥, 𝜏) = 𝑓

2,э
(𝜏) +

𝑥2

2!
𝛧1(𝜏) +

𝑥4

4!
𝛧2(𝜏) + ⋯+

𝑥2𝑁

(2𝑁)!
𝛧𝑛(𝜏) +

𝑥2

𝜆3
𝑔
2
(𝜏) + +

𝑥4

3!𝜆3
𝛧1
∗(𝜏) +

𝑥6

5!𝜆3
𝛧2
∗(𝜏) + ⋯+

𝑥2𝑁+2

(2𝑁+1)!𝜆3
𝛧𝑁
∗ (𝜏), 

14 ∫ ∫
+∞

−∞
∫
+∞

−∞
𝜙
1
∗(

𝑡∗

0
𝑛
𝜕𝜙1

𝜕𝑡
+

𝜕𝑢𝜙1

𝜕𝑥
+

𝜕𝑣𝜙1

𝜕𝑦
+ 𝜎𝜙

1
−

𝑑𝑖𝑣(𝜇𝛥𝜙
1
))𝑑𝑥𝑑𝑦𝑑𝑡 =  

= ∫ ∫
+∞

−∞
∫
+∞

−∞

𝑡∗

0
∑ 𝑄і
𝑁
і=1 𝛿(𝑥 − 𝑥і)𝛿(𝑦 − 𝑦і)𝛿(𝑡 − 𝑡0)𝜙1

∗𝑑𝑥𝑑𝑦𝑑𝑡.  

15 𝜀𝑥
(𝑘)
= ∑ 𝑃𝑚𝑢𝑚,𝑥

(𝑘)3
𝑚=0 , 𝜀𝑧

(𝑘)
= ∑ 𝑃𝑚

′ 𝑤𝑚+1
(𝑘)2

𝑚=1 , 

 𝛾
𝑥𝑦
(𝑘) = ∑ 𝑃𝑚(𝑢𝑚,𝑦

(𝑘)
+ 𝑣𝑚,𝑥

(𝑘)
)3

𝑚=0  𝛾
𝑥𝑧
(𝑘) = ∑ (𝑃𝑚𝑤𝑚+1,𝑥

(𝑘)
+ 𝑃𝑚

′ 𝑢𝑚
(𝑘)
)3

𝑚=0  

16 𝜎2(𝑡, 𝑥) = 𝐸2(𝑡 − 𝜏 ∗ (𝑥)) 𝜀2(𝑡, 𝑥) −  

∫ 𝜀2(𝜏, 𝑥)
𝑡

𝜏∗(𝑥)
 𝑅 (𝑡 − 𝜏 ∗ (𝑥), 𝜏 − 𝜏 ∗ (𝑥)) d𝜏; 

𝜌
1
𝑐1

𝜕𝜃1(𝑡,𝑥)

𝜕𝑡
=

𝜕

𝜕𝑥
(𝜆1

𝜕𝜃1(𝑡,𝑥)

𝜕𝑥
), 
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Task 3. Formatting tables 

Create the following table: 

Use table styles and the Table design and Layout tabs of the 

Table tools menu. 

Indicator name 

 

Field of knowledge, 

training direction 

Characteristics of 

the academic 

discipline 

full-time education 

The number of 

credits – 3 

Field of knowledge 

0305 "Economics and 

entrepreneurship" 

Selective 

Modules - 1 

train
in

g
 d

irectio
n
 

6
.0

3
0
5
0
3
 

"In
tern

atio
n
al 

E
co

n
o
m

y
" 

Year of training: 

Content 

modules - 1 

3rd 

The total 

number of hours 

– 108 

Semester 

the 6th 

Lectures 

Weekly hours 

for full-time 

education: 

classrooms – 2 

 

 E
d

u
ca

ti
o

n
al

 q
u

al
if

ic
at

io
n
 

le
v

el
: 

b
a

ch
el

o
r 

 

20 hours 

Practical, seminar 

- - 

Laboratory 20 hours  

Independent work 

Individual tasks 

Type of control: 

settlement 

 

 

Task 4. Work with drawings 

Insert a picture into the document using the Insert menu, item 

SmartArt . Change color and styles using the SmartArt Tools tab. 
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Make a caption of the figure 14 pt, Times New Roman 

alignment in the center: " Fig.1. Figure Microsoft Word ". 

Create the following figure using standard elements from the 

Shapes  menu: 

 
 

The student can make his own design of figures and tables 

 

Report on laboratory work №3. 

 The report file contains the title page, table of contents, 

completed tasks are numbered and placed on separate sheets. 

  

B1 Text

A2Scheme A2

C3 Module



 

18 
 

Laboratory work № 4 

WORD TOOLS FOR WORKING WITH 

ELECTRONIC DOCUMENTS 

 
Goal: To acquire the skills of creating documents with 

automatic updating of references, numbering of tables and figures and 

the list of used literature, to create multi-level lists, cross-references, 

subject references, bookmarks, footnotes, hyperlinks. 

 

Task 1. Automatic numbering of tables and figures 

To perform the tasks of laboratory work №4, you can use the 

formatted text from laboratory work №2. If unformatted text is used, 

the following actions must first be performed: 

- To clear the formatting, you need to select all the text "Ctrl+A" 

and apply the Clear Formatting command . 

- Select the entire document and apply the Normal style to it by 

following the command sequence Home → Styles → Normal. 

- Apply 1st-level style to section titles. To do this, select the 

appropriate names of the sections and execute the sequence of 

commands: Home → Styles → Heading 1. 

- Use the 2nd level style for subsection names. To do this, 

highlight the appropriate names of the subsection and execute 

the sequence of commands: Home → Styles → Heading 2. 

- Create document content. To do this, you need to follow the 

sequence of commands: References → Table of contents → 

Contents.. or click on the table of contents and select Update 

Entirely. 
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Task 2. Multilevel lists 

For automatic numbering of 

sections and subsections in the 

document, you need to go to the 

Home tab "Multilevel list" and select 

from the library of ready-made lists a 

style that provides for the numbering 

of sections of the type 1,2,3... and 

subsections 1.1;1.2;... 

If the document is formatted 

correctly, the numbering of all 

sections and subsections will be 

automatically updated. For more 

complex formatting of section 

numbering (for example, to 

automatically add words to the title of 

the section), use the command Define 

new multilevel list.. 

To quickly navigate through a 

formatted document, you can execute 

the sequence of commands View → 

Navigation 

Pane. 

 

 

For the appearance of numbering in the 

table of contents, it must be updated using the 

command sequence Update field → Update 

entire table. 

 

 

 

 

Task 3. Automatic numbering of tables 

Automatic numbering of objects (tables, figures) in Word will 

be carried out correctly, if the text is formatted with styles and the style 
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of multi-level lists is defined (the previous 

paragraph of laboratory work). 

Add a table to the formatted text 

using the Insert Table menu. Select the 

table and execute the Insert caption 

command, setting the following options 

Label - Table; Position - above selected 

item; Numbering - Include chapter 

number, Use separator - period. 

 

  
As a result, we will get an automatic table number. If the format 

of the number (location, font, font size, line spacing) does not comply 

with the norms (14 pt non-bold font, alignment on the right edge), it is 

necessary to correct the Object name style parameters.  
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For verification, it is necessary to insert another table and 

automatically number it. To do this, you only need to select the Insert 

caption item and click OK. All other settings (number, font, 

alignment) will be made automatically. 

Students need to set the automatic numbering of all tables in the 

text. 

Task 4. Automatic numbering of figures  

For automatic numbering of figures, it is necessary to insert a 

figure and perform actions similar to the numbering of tables, taking 

into account that the name of the figure is located under the object, 

aligned in the center and has the form 

Fig. 1.1 Name of the drawing 

 

Task 5. Cross-

references 

For automatic tracking 

of changes in references, 

Word 2019 offers the Cross 

References tool.  

To add a cross-

reference to the document, 

select the command Insert → 

Links → Cross-reference.  
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The type of cross-link is specified in the Reference type list, and 

the object to which this link will point is specified in the Insert 

Reference to list. For each type of link, a list of objects is offered in 

the Insert Reference to list. For example, if the link is of the Heading 

type , then in the Insert Reference to list, you can set the Heading text 

so that the title text is inserted directly into the link text, and you can 

select Page number so that only the page number on which it is located 

is inserted into the link text given title. The heading itself can be 

selected in the For which heading list at the bottom of the window. In 

addition to the title text and page number, the link can contain the title 

number, as well as simply indicate whether the referenced text is 

located above or below (above/below). 

To create links in the text to the number of the table or figure, 

you need to go to the menu Insert → Links → Cross-reference. In the 

Reference type list, specify the type of cross-reference Table or Fig. 

and a specific table or figure is selected. 

The student must cross-reference one section and all tables and 

figures in the text. 

 

Task 6. Creating a list of used literature 

Another type of list that can be automatically created in Word 

2019 is a bibliography. In the bibliography, you can place a list of 

literature and other sources of information that were used in the 

creation of the document. 

The principle of creating a bibliography is the same as for a 

table of contents or a list of figures: first you need to tell Word 2019 

what to list, and then create it. First, note the citations in the text and 

indicate the source for each. Then a list of created sources is inserted 

on the selected page. 

All commands for creating a list of used sources are in the 

Citations&Bibliography lists of the References tab. 
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First of all, it is necessary to decide on the design style of 

citations in the text and in the list itself. Depending on the chosen style, 

both references to sources in the middle of the text and the list itself 

on the bibliography page will be formatted differently. You can set the 

appropriate standard (we use the IEEE 2006 standard) in the Style list.  

After the bibliographic data design standard has been selected, 

you need to go to the place in the document to which the external 

source corresponds and place the cursor where the name of the source 

in brackets will be located. This is usually the end of a paragraph or 

quote. By clicking on the Insert link button choose one of the available 

menu items Add new source, the Create Source dialog will appear. 

 
In the Type of Source drop-down list, select the type of source: 

book, book section, journal article, article in a periodical, conference 

proceedings, report. 

After the work on the document is completed, and all the 

included sources are formatted, you can add a bibliography with a list 

of them. To do this, place the cursor in the place where the 

bibliography will be inserted, and press the Bibliography command . 

In the drop-down list, choose one of the three bibliography templates. 

References and Works Cited templates place lists of sources on 

separate pages. A container field is added, inside which there are 

separate fields for each source. If not all sources have been fully 

formatted, but empty container fields remain, they will not be included 

in the list. 

 

To update the table of contents, bookmarks, links, list of 

sources, numbering of tables and figures, indexes, it is necessary to 
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select the entire text or a certain list and press the F9 button on the 

keyboard or Update ... in the drop-down list. 

 Students need to create a list of used literature from at least 5 

sources. 

 

Task 7. Document review 

To review a document, 

click the Show markup button in 

the Tracking group on the Review 

tab. Here you can specify the 

changes of which elements should 

be tracked in the text, the ability to 

observe all corrections in the 

document at the current moment, 

as well as the total number of 

corrections and the number of 

corrections of each type. These summaries 

can be seen by bringing up the Reviewing 

pane window. 

  

When viewing corrections and 

notes, you can accept or reject any of them. Until all corrections and 

notes made to a document are accepted or rejected, even hidden 

changes will appear in displayed or sent documents. Actions for 

accepting or rejecting changes are combined in the Changes group on 

the Review tab. The changes is indicated by the full name of its author, 

the date and time of creation. 

The student needs to make several corrections to the text. 

 

 

Report on laboratory work №4. 

The report file contains the title page, table of contents, tasks 1-

8 are performed in the text. The results of task 9 are copied and added 

to the report file and included in the content of the report. 
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Module 2 

Laboratory work № 5 

CREATING TABLES AND GRAPHS IN THE 

EXCEL ENVIRONMENT. USE OF FORMULAS 
 

Goal: To acquire the skills of creating tables and graphics in the 

MS Excel environment. 

 

Task 1. It is necessary to calculate the wages of employees 

using formulas with relative and absolute references.  

Progress: 

1. Create a table of initial data according to the template 

presented in the figure of columns A, B, C, D. 

2. Perform calculations using the formulas in columns E-H .  

 

 
Fig. 1. Calculations 
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Task 2. Creating diagrams 

Based on the data on the quantitative composition of students 

of the educational and scientific institute of economics and 

management, create and design a diagram. For better visual 

perception, similar data are displayed in pie charts. 

Progress: 

1. create the table shown in Fig. 2. 

2. select the range of cells A3:B10 (Fig. 1); 

3. on the Insert tab, in the Charts group, select the type of 

chart Pie→3-D Pie 

4. using the Chart design tab → Charts Layouts → Add Chart 

Element → Chart title, place the name of the diagram above chart. 

5. using the tab Chart design tab → Charts Layouts → Add 

Chart Element → Data labels→ More data levels options check the 

points Category Name, Percentage, Show Leader Lines.   

 
Fig. 2. Creating a pie chart 

 

Task 3. Creation of histograms. 

Based on tabular data about population in the Rivne region from 

2003 to 2022, create and design a diagram. It is convenient to present 

similar data in histograms. 

Progress: 

1. form the table shown in Fig. 3. 

2. select the range of cells A3:B22 containing the original 

data (Fig. 3); 
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3. on the tab Insert, in the Charts group, select the type of chart 

Column; 

4. using the tab Chart design tab → Charts Layouts → Add 

Chart Element → Chart title, place the name of the diagram above 

chart; 

5. for chart axis labels you need to choose Add chart element 

→ Axis title → Primary Horizontal and Primary Vertical. 

 
Fig. 3. Construction of a histogram based on tabular data 

 

Task 4. Calculation of the function value 

Calculate the value of the function 

𝑦 =
(3𝑥 + 2)2

𝑠𝑖𝑛 𝑥 + 3
 

provided that 

4,8 ≤ 𝑥 ≤ 7,6, 

𝑑𝑥 = 0,4, 

and graph the function. 

Progress: 

To fill the table with function values, you must first place the 

output data: step dx=0,4 placed in cell D5. In the header of the table 

we will place the designations of the variables x and y.  
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The next step is to fill column x with the values of the 

corresponding argument. To do this, enter the initial value in cell A6 

х (4,8), and in cell A7 – the formula for calculating the remaining x 

values: =A6+D5. Since the value dx is constant, it will not change 

during the calculation and needs an absolute address. To do this, you 

need to press the function key near the address D5 in the formula bar 

<F4> – $D$5.  

Move the mouse cursor to the lower right corner of cell A7, 

which already contains the formula, so that it takes the form of a solid 

cross, press the left mouse button and "pull" down until the value in 

some cell of column A becomes 7.6. 

Let's go to the column with the function values. Enter the 

formula for calculation y in cell B6 

=(3*A6+2)^2/(SIN(A6)+3). 

To autofill this column, you should repeat the steps for copying 

the formulas. In fig.4 the result of performing operations in formula 

mode is given. 

To construct a graph of a function, the following steps should 

be performed: Insert → Charts group → Scatter → Scatter with 

smooth lines and markers. The appearance of the resulting diagram 

can be improved as follows:  

• select the chart on the tab Chart design → Charts Layouts → 

Add Chart Element → Chart title, place the name of the diagram above 

chart and sign the names of the axes (Axis titles); 

• press the right mouse button on the OX axis, select the item in 

the context menu Format axis → Axis Options → Bonds → Minimum 

and appoint 4.  
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Fig. 4 Step-by-step calculation of function values 

 

Fig. 5 Construction of a scatter based on tabular data 

Task 5 Logical functions 

Theoretical information 

Logical functions are an integral component of many formulas. 

If it is necessary to implement certain actions depending on the 

fulfillment of some conditions, you should use logical functions. 

Logical functions are included in the category Logical of the window 

Formulas. Logical functions include:: 
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• IF (logical_test, value_if_true, [value_if_false]) is used to 

select one of the alternatives depending on the given condition. For 

example, the formula "=IF(A6<20;5;10)" returns the number 5 if the 

value in cell A6 is less than 20, and in the opposite case – 10. 

LOG_expression is any logical condition that acquires a value 

TRUTH  or FALSE; 

• AND(logical_test1; logical_test2;…) used to combine two or 

more conditions; 

• OR(logical_test1; logical_test2;…) checks input values and 

returns values TRUTH, if at least one of the arguments is valid 

TRUTH; 

• NOT(logical_test) reverses the value of its argument. 

 

It is necessary to calculate the wages of employees taking into 

account changes in tax legislation. Income tax in the amount of 18% 

is charged only to those employees whose accrued wages do not 

exceed UAH 2,000. Who has an accrued salary of more than UAH 

2,000, the income tax is 20%. 

Progress: 

1. Copy the table from task 1 onto a new sheet: 

2. Clear the data from the column Income tax 

3. Using the function IF of Logical categories from the menu 

Formulas in cell F10 describe the new tax calculation mechanism. 

4. Copy the contents of cell F10 to all other employees. 

 
Fig. 6 Defining function argument 
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Task 6. Statistical functions. 

The following functions from the Statistical category are often 

used to process statistical data. 

Using the array X and Y from the previous task to find 

1. Correlation coefficient between arrays X and Y. (CORREL 

(array 1; array  2). 

2. F-statistics (F.INV.RT (probability – 0,05; deg_freedom 1 – 

1; deg_freedom 2 – 8) – finds the F-probability distribution for two 

sets of data. 

3. STDEV (number 1; number 2;) – finds the standard 

deviation based on the sample. 

 

Task 7. Mathematical functions. 

1. Enter the current year and day of the month in separate cells 

and convert them in the adjacent cells to the format of Roman 

numerals (function Roman). 

2. Find the root of any number using the function SQRT. 

3. Calculate 103 using the function POWER. 

4. Find the cosine of the number 4 using the function COS. 

5. Find the factorial of the variant number using the function 

FACT. 

 

Task 8. Date and time functions. 

1. Insert the current date into the cell. (function TODAY or NOW) 

2. Insert the date of birth in the cell in the format Date. 

3. Find the number of days lived. (subtract the birthday from the 

current date). 

4. Find the weekday on which you were born (function 

WEEKDAY() function arguments select birthday references 

and Type - 2. 

 

Task 9. Lookup and reference functions. 

To convert the X:Y array from vertical to horizontal, you need 

to select a range of empty cells with a dimension of 11×3, select the 

function TRANSPOSE from the category Lookup and reference, select 

the range with the output array and press the keys 

<Ctrl>+<Shift>+<Enter>. 
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Task 10. Financial functions 

Theoretical information 

An important area of MS Excel tools is related to the 

implementation of financial calculations. The main financial functions 

are as follows: 

• FV(rate, nper, pmt, [pv], [type]) one of the financial 

functions, calculates the future value of an investment based on a 

constant interest rate. You can use FV with either periodic, constant 

payments, or a single lump sum payment. The FV function syntax has 

the following arguments: 

• Rate (nper, pmt, pv, [fv], [type], [guess]) – Required. The 

interest rate per period. 

• Nper (rate,pmt,pv,[fv],[type]) – Required. The total 

number of payment periods in an annuity. 

• Pmt (rate, nper, pv, [fv], [type]) – Required. The payment 

made each period; it cannot change over the life of the annuity. 

Typically, pmt contains principal and interest but no other fees or 

taxes. If pmt is omitted, you must include the pv argument. 

• Pv (rate, nper, pmt, [fv], [type]) – Optional. The present 

value, or the lump-sum amount that a series of future payments is 

worth right now. If pv is omitted, it is assumed to be 0 (zero), and you 

must include the pmt argument. 

Remark. All arguments representing money to be paid are 

represented by negative numbers; funds to be received - in positive 

numbers. 

 

Financial function of FV 

The client put 1,000 hryvnias on deposit in the bank at a rate of 

10% per year. Calculate the future value of his deposit in 5 years using 

the compound interest rule.  

Accrual by the method of compound interest means that at the 

end of the first year interest is accrued on the deposit in the amount of 

1,000 x 0.10 = UAH 100. This amount is added to the initial deposit 

amount. At the end of the second year, interest is accrued in the 

amount of UAH 1,100, i.e. UAH 1,100 x 0.10 = UAH 110. and so on.  

Progress: 
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1. Enter the notation PV = 1000; n = 5; r = 10% (fig. 7). FV – 

the value of the deposit after 5 years, and enter this data into the 

MS Excel table (cells B1:B3). 

  
Рис. 7. Results of the FV function 

 

2. In the Financial Functions menu, we find the FV function, 

which allows you to calculate the future amount, taking into account 

interest charges. As arguments in the window of the function that 

appeared, we enter links to the corresponding cells: RATE = 0.1; 

NPER = 5; PV = -1000. Standard notation of arguments is used here: 

NPER – number of periods (years), PV – initial deposit amount. In 

computer calculations, the value of the deposit rate is always entered 

in fractions of a unit. 

 
Fig. 7 Use of financial functions FV 

 

3. After pressing the OK key, the result of performing the FV 

function is displayed in cell B4 – the value is 1610,51.  

 

Report on laboratory work № 5. 

Reports for laboratory works 5-7 are drawn up in the form of 

Excel files. Each task is performed on a separate sheet of the file. 
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Laboratory work № 6 

OPERATIONS ON MATRICES. ANALYSIS AND 

FORECASTING USING EXCEL 
 

Goal: Get the skills to perform operations on matrices, as well 

as get the skills to perform economic analysis and build predictive 

models using MS Excel. 

 

Theoretical information 

Functions for working with matrices 

A significant number of economic and mathematical models of 

various objects and processes are recorded in array form. In MS Excel, 

matrices are presented in the form of arrays (blocks of adjacent cells). 

When performing operations with matrices or vectors, solving systems 

of equations, etc., you can use the following MS Excel functions: 

• Minverse (array)– finding the inverse array; 

• Mdeterm (array) – finding the determinant of the array; 

• Mmult (array 1 ; array 2) – product of two matrices; 

• Transpose (array) – transposition of matrices. 

Actions with elements of the array (array) should be performed 

in a certain sequence: 

• before entering the necessary function to perform certain 

operations on arrays, you need to select a range of free cells in which 

the result will be displayed. 

• enter the necessary formula. 

• select ranges of initial array values. 

• press the key combination <Ctrl>+<Shift>+<Enter>. 

When entering an array formula, MS Excel automatically 

encloses the formula in curly brackets. 

An individual cell of the calculated array cannot be changed. 

You can change only the entire array at once, for this it must first be 

selected. 

Multiplying a array by a number. First, you need to enter the 

elements of the array, for example, in the range of cells A2:C4. To 

multiply the entered array by the number 5, a range of free cells is 

selected according to the size corresponding to the given array (for 

example, D2:F4). Next, enter the formula =A2:C4*5 in the formula 
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line and press the keys <Ctrl>+<Shift>+<Enter>. The values of the 

original data multiplied by 5 appear in the selected range of cells. 

Transposition of array. To do this, use the function 

TRANSPOSE, which translates the vertical range of cells into 

horizontal, and backward. For example, it is necessary to create a 

transposed array from the elements of array A. Select a range of cells 

into which the new array will be entered (A7:C9), select a function 

TRANSPOSE and enter the corresponding values of the elements of 

array A: TRANSPOSE (A2:C4). Keys are pressed 

<Ctrl>+<Shift>+<Enter. 

Calculation of the array determinant 

Remark: you can calculate the determinant only for a square 

array. 

To calculate the determinant of an array, call the function 

MDETERM. For example, you need to find the determinant of the 

array A. First, select the cell in which the value of the determinant (E7) 

will be placed, call the function MDETERM. Enter the corresponding 

values of the elements of array A and press the key <Enter>. 

Multiplying an array by an array 

To perform this operation, use the function MMULT (array 1; 

array 2), where array 1, array 2 – are arrays that are multiplied. The 

number of columns in the array 1 argument must be equal to the 

number of rows in the array 2 argument. When multiplying an array 

by a vector, the calculated array is a column array, the dimension of 

which coincides with the dimension of the vector. 

To multiply an array by an array, you must enter the array into 

a range that must have as many rows as there are columns in the array. 

Next, select a range of cells where a new array will be created, activate 

the button Insert function, select a function MMULT (category Math 

and Trig) and enter the links of the ranges of array A and vector B. 

After that, press the keys <Ctrl>+<Shift>+<Enter>.  

Calculation of inverse arrays 

Remark: the inverse array is constructed only for a square non-

degenerate array whose determinant is different from zero. 

To calculate the inverse array, activate the function 

MINVERSE. For example, it is necessary to create an inverse array 

from the elements of array A. To do this, select a range of cells where 

a new array will be created, and activate the function MINVERSE. 
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Enter the corresponding values of the array elements and press the 

keys <Ctrl>+<Shift>+<Enter>. 

 

Task 1. Accordingly, the initial data of the array A, it is 

necessary: 

• multiply the array A by the number 10; 

• find the transposed array to the array A; 

• calculate the determinant of array A. 

 
Fig. 8 The initial data of matrix A 

 

Task 2. Solve the system of linear algebraic equations by the 

array method: 

{

1,9𝑥1 + 7,1𝑥2 + 3𝑥3 = 5,8,
6,4𝑥1 + 𝑥2 + 4,3𝑥𝑥 = −7,5,
2,7𝑥1 − 1,9𝑥2 + 6,2𝑥3 = −4,5.

 

To find the solutions of the system of equations, you need to use 

the formula 

𝑋 = 𝐴−1 × 𝐵. 

Where 𝐴 – array of coefficients with unknowns,  

𝐴−1 – inverse array,  

𝐵 – vector of free members,  

𝑋 – vector of wanted unknowns. 

 

Task 3. Construction of trend lines. 

Theoretical information  

In the modern economy, in order to make various kinds of 

decisions, it is necessary to be able to forecast the development of the 

economic situation. For this, it is necessary to know the past well and 

its inherent patterns. If various economic indicators are recorded 

regularly over a long period of time, such data form a time series. 
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Thanks to statistical analysis, it is possible to identify and use 

the information contained in the time series for forecasting. For visual 

analysis of time series in MS Excel, charts are used and trend lines are 

built. 

Trend line – it is a function of a given type, with the help of 

which it is possible to detect the development trend of a particular 

process and provide a forecast for a given period. 

MS Excel provides several types of trend lines. 

Table 1 

Dependency type Equation 

Linear 𝑌 = 𝑎 + 𝑏𝑋 

Polynomial 𝑌 = 𝑎 + 𝑎1𝑋 + 𝑎2𝑋
2+. . . 𝑎𝑛𝑋

𝑛 

Logarithmic 𝑌 = 𝑎 𝑙𝑛 𝑋 + 𝑏 

Exponential 𝑌 = 𝑎𝑒𝑏𝑋 

Power 𝑌 = 𝑎𝑥𝑏 

 

Where 𝑌 та 𝑋 – some economic variables between which the 

relationship is studied (Y is considered a dependent variable of X).  

Task condition 

Some company has observed the demand and price of its 

products. Observation data are summarized in a table. It is necessary 

to determine the quantitative dependence of demand on price and 

apply the obtained dependence for forecasting and analysis of demand 

for products. It is believed that the dependence has the form of paired 

linear regression 

𝑌 = 𝑏0 + 𝑏1𝑋, 

which can also be written as 

𝑌 = 𝐴𝑋 + 𝐵, 

where  

Y – demand;  

Х – price;  

А, В or b0, b1 – model parameters. 

Progress:  

1.  Create a table of output 

data according to the sample in the 
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following figure. To calculate the 

values of Y, add your option 

according to the group list to the 

demand values (formula 

=C4+$C$1 in cell F4, press F4 and 

copy to the entire column Y).  

2. Construct a scatter 

plot. 

3. Add a linear trend 

to the already constructed chart: 

• Select all the points on the 

constructed diagram; 

• add a trend line (right 

mouse button →Add trendline); 

• Trendline options (select 

the type of trend line), set 

parameters Display equation on 

chart, Display R-squared value on 

chart. 

The linear regression 

equation appears in the chart box, 

along with the confidence value of 

the approximation R2 . 

 
Fig. 9 Raw data and trend line with forecast demand values 

Task 4. Building a forecast for N years using a trend line. 

To change the trend line, you need to select it from the context 

menu Format trendline. 

Using the trend line, it is possible to predict the dynamics of the 

development of one or another economic process for the following 
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periods. To do this, you need to fill in the window with the number of 

periods in the Format trend line context menu in the Forecast group. 

As a result of the above actions, we will get a trend line and a forecast 

for three years. 

Task 5. Finding and 

analyzing a regression 

equation using the Data 

Analysis add-in. 

To obtain comprehensive 

information, which is necessary 

for a detailed study of the model 

for the purpose of its further use 

for forecasting and economic-

mathematical analysis, it is 

necessary to use the tool 

Regression Data Analysis add-

in. 

If the add-in is not 

installed, it is required in the 

menu File to choose Options, 

Add-ins and add Analysis 

toolpack and Solver add-in. Add-

ons will appear in the menu Data.  

Progress: 

1. Copy the X, Y data table to a separate sheet (think 

about how to save the connections between the sheets ☺). 

2. Select the tab Regression Data Analysis add-in from 

the menu Data.  

3. Give Input range for Y and X (if the column names 

are included in the intervals, put them Labels), Output range (one cell 

on the active sheet). As a result, we get model parameters  

Y – intersection - В or b0. 

X – А, or b1. 

4. Find the predicted demand value Y for the predicted 

price value Х=32. With the help of the function FORECAST or from 

the equation. 
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Fig. 10 Regression results 

 

Task 6. Finding the parameters of the regression equation using 

a function. 

The parameters of the regression equation can also be found 

using functions. 

To find the parameter b0 function must be applied Intercept, b1 

– Slope (Statistical functions). 

As a result, it is necessary to compare the parameters of the 

regression equation obtained by different methods: 

-  Graphically using a trend line;  

- tabs Regression data analysis package; 

- functions Intercept and Slope. 

 

Laboratory work № 7 

OPERATIONS ON LARGE DATA ARRAYS. 

CONDITIONAL FORMATTING, SMART TABLES 
 

Goal: Get the skills to perform operations on large data arrays 

and format them. 

 

Theoretical information 

Conditional formatting is a way to make working with Excel 

spreadsheets as easy as possible. This method of processing 

information allows you to save a lot of time and facilitate all 

calculations. You can make the program automatically perform many 

tasks that used to be done manually, wasting a lot of time. 
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In addition, for your convenience, you can configure Excel so 

that it immediately selects the necessary or important information in 

the documents. In addition, such formatting will help to display 

information more clearly, quickly and efficiently create reports 

without using complex graphic models, such as charts or graphs. 

"Smart" table is a special type of formatting, after applying 

which to the specified range of data, the array acquires certain 

properties. First of all, after that, the program begins to treat it not as 

a range of cells, but as a complete element. If you make an entry in 

any cell that is located directly near its borders, then the row or column 

is automatically included in this tabular range. 

The use of this technology allows you not to recalculate 

formulas after adding rows, if the data from it is pulled into another 

range by a certain function. In addition, among the advantages should 

be selected the fixing of the cap at the top of the sheet, as well as the 

presence of filter buttons in the headers. 

In a "smart" table, by default, when it is created, useful tools are 

automatically connected, which provide sorting and filtering of data. 

As you can see, there are already icons in the form of triangles 

in the cap near the names of the columns in each cell. It is through 

them that we get access to the filtering function. We click on the icon 

near the name of the column we are going to manipulate. After that, a 

list of possible actions opens. 

Pivot tables are one of the most powerful MS Excel tools for 

analyzing databases placed in tables or lists. The summary table not 

only groups and summarizes the data, but also provides an opportunity 

to conduct an in-depth analysis of the available information. When 

creating a pivot table, the user specifies the names of the fields placed 

in its rows and columns. It is also allowed to specify a page field, 

which allows you to work with a summary table as with a set of sheets. 

Pivot tables are convenient for data analysis for several reasons: 

- allow you to create summarizing tables that provide the 

possibility of grouping the same type of data, summarizing, and static 

characteristics of records; 

- easily transformed; 

- allow automatic selection of information; 

- on the basis of the summary tables, diagrams are built, which 

are dynamically rebuilt along with the change of the summary table. 
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Task 1. Conditional formatting. 

It is necessary to Select in color the prices of phones in the range 

of 80-160 $. 

Progress: 

1. Create a table according to the sample. 

2. Select the data in the price column. 

3. Choose from the menu Home the tab Conditional 

formatting, Highlight cells rules; Between. 

4. Set formatting borders and color. 

5. Select the data in the Quantity column. 

6. Choose from the menu Home the tab Conditional 

formatting, Data bars and select the fill type. 

 
Fig. 11 Conditional formatting results… 

 

7. Copy the Quantity column to the adjacent column and 

select it. 

8. Select in the tab Conditional formatting, Color scales 

or Icon sets and select the fill type. 

 

Task 2. Smart table. 

Create a smart table, add data to it and summarize. 

Progress: 

1.  We copy the table from the previous task to a new sheet, 

remove conditional formatting and add a column. 

2. Select the table. 

3. Choose any table style from the tab Format as table from the 

menu Home 
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4. Add a new Sales Volume 

column to the table and enter the 

formula: Price*Amount.  

5. In the menu Table design 

which is activated when you click on 

any element of the smart table 

activate the item Total row. 

6. For the Price column, we 

define the average price. 

7. Check out other Smart 

Table Builder features. 

 

Task 3. Sorting and 

filtering.  

Sort and filter data in a 

smart table and using a tab Sort 

and filter. 

 

Progress: 

1. Sort the table 

by phone price from minimum 

to maximum. 

2.  Copy smart 

table data to a separate sheet and 

convert it into a regular data 

range (command Convert to 

range from the menu Table 

design). You can also type a 

new table. 

3. Sort a regular 

table using a tab Sort and filter 

from the menu Home. 

 

4.  Add a note to 

cell A1 of any content using 

Reviev → Notes → New note. 

 


